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MIT Libraries

RefWorks Basics

Instructor: Howard Silver, hsilver@mit.edu, x3-9319

Overview
o What is Bibliographic Software, and why it is worth knowing about.
e Hands-on practice with RefWorks

- Create an account & collect references

- Manuscript creation

- Using library resources to populate your database

- Managing your database & Getting Help

. Go to RefWorks, create an account

RefWorks
Go to library’s RefWorks support page: Help
Yourself, then under Organize your References or New User Information
http://libraries.mit.edu/help/refworks/index.html Massachusetts Institute of Technology | |
Click on RefWorks link, select Login from menu v
bar' Login Name: ¢
To create a new account click on Sign up for an [
Individual Account link (above the Log-in name
Re-enter Password:
entry box.
Complete registration form (7 fields) and click sl e !
Register button. Type of User
Select a User Type v
?::; eu étF: ::zcl_,l s Area -
Select a Focus Area
Health Sciences and Technolo
Lincoln Labs
IOther
School of Architecture and Planning
S oo o B eer g e eteand s

I1. Get records from PubMed

From the Search pU||-d0WH References ~ Search -|View - Folders - Bibliography | Tools ~ Help -

ge?ul’ selecgsetall;(:h Online Search Online Catalog or Database

atalog or batabase.

Select PubMed from Search Online Catalog or Database to Search:

pull-down menu. PubMed

|_|m|t retneval to 10 records Max. Number of References to Download: | 10 hd

Enter Search terms (eg Wind QI..Ii(;k Search for: (with Quick Search on PubMed you can simply enter terms you are interested in
. wind power

power) click Search button

Reguest a Z33.50 Site
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5. RefWorks opens a NEW
browser window and imports

records from the catalog. RefWorks
6. Atthe tOp of the list of Search Results for "wind power”
references _Se I eCt the A_I I I n LISt Elelftniin[?upsflzeﬁml;" Lif;ute that references are also put in the Last Imparted folder)
import option, then click Plrarios s T
Book Title: Power from the wind
I m pO rt bUtton " Authors: Putnam Palmer Cosslett
7. Close the catalog search Sowee: 1974, 24, Van Nosrand Reinbold, New York
WI ndOW . Boolec Tiﬂle: Windworks: a bibliography
- Authors: Wolf Ben
8. From the main RefWorks page, Source: 1975, 730, 38, Council of Planting Librarians. Monticello, IIL
1 H Orefo: 3 Book, Whole Reference 3 of 10
CI ICk the VIeW pu I I -down men u 3 Book Title: Exploiting wind power for the production of electricity
1 1 Authors: Johansson, M. ; United States. National Aeronautics and Space Administration
Ze I e(l:t AII!] relfoe rences’ ghs Vt\)lll\l/: d Source: 1974, 36. ]\'atimaltAer;ntautics a:d SpacaAd.r:irﬁstraﬁmf '\Vashjngton?’];c,
|Sp ay t e |mporte u e _Dmf,: o B Book, Wh.ale Referen:e.“» of 10.

records.

I11. Create a manuscript and bibliography

1. Open Word. Begin manuscript by typing a
sentence. Save document to desktop. ' = :
2. Click Write-N-Cite icon in Word toolbar. : . .
This will open a streamlined version of your % g B Write-N-Cite
RefWorks account that will allow you to cite L\\b
references and generate a bibliography.
3. Login to your RefWorks account (again).

Your list of references will be listed with two
action options — View and Cite.
4. To insert citation into your manuscript, click | [SAAEESES

B RefWorks write-s-Cite

My great paper {{3 Church,G. M. 2005;20 Fenstermacher. David 2005; }}

the Cite option next to the citation want to e B o
insert. Repeat as often as needed. kb orasiin
5. When you are ready to generate your o P ——— i —

bibliography and format your citations,
select the Bibliography pull-down menu in
the Write-N-Cite window.

6. Select an Output Style from the pull-down
menu, then click Create Bibliography
button. Write-N-Cite will automatically save
the new document to your desktop, with the
name Final.xxx.doc. If you want to revise
your document, add more references, or RefWorks New Refbor
change output styles, you must make these teferences - Search - View - Folders - Bibliography | Tools - Help -
changes on your original document, and then | search online catalog or Database *:’1:;5?1

repeat previous steps to ensure that newly e e Import EndNote V&+ Database

added cited references, or other revisions, are | 'PuMed Export References

included in your final bibliography.

Note: Write-N-Cite is a plug-in that you
download from the RefWorks website. Go to
the Tools pull-down menu to download plug-in.
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V. Build a RefWorks database

A. Create a folder, and move citations

From Folder pull-down menu, select

T |
References - Search ~|View ~ Folders ~ Bibliography | Tools ~ Help ~

Create New Folder (e.g. Wind).
Transfer all of your citations into new
folder, using All in List option, and Put
in folder pull-down menu.

Create New Folder

New Folder Name: |

Create New Folder
View \“_") 4
Organize Folders
Share Folders

B. Get more citations - catalog (Barton)

1. From the RefWorks Search pull-down
menu, select Online Catalog or
Database option

2. Select MIT from database pull-down

menu

Limit retrieval to 10 records

4. Enter search terms (eg wind power)
click Search button

5. RefWorks opens a NEW browser
window and imports records from the
catalog.

6. At the top of the list of references select
the All in List import option, then click
Import button.

w

References = Search = View = Folders = Bibliography Tools = Help =

Search Online Catalog or Database  w...siezoan

online Catalog or Database to Search:

MIT
M, Number of References to Download: |10 || N
Quick Search 1or:  (Quick Search results are based upan the fielis supgorded by the hest site that yeu have
wind power
[ search | [ clear |
Advance: d Search for:

C. Get more citations — direct export

w

Open new browser window to library
homepage, http://libraries.mit.edu.

Go to VERA and type ProQuest
Research Library in search box, open
database.

All sources @ Scholarly Journals  Magazines Trad

231 documents found for: wind power > Refine Search | Set Up Alertig

Search on “wind power” in Title field.
At the Results page click Mark all box,
then the Export button.

At the Export page, select RefWorks as
the Export to option.

The RefWorks window will open (you
may need to log in again), and the
records will be imported into the Last
Imported folder.

View Last Imported folder and move
all (or selected) citations into Wind
folder.

Export citations into

# Mark all ¥~ 10 marked items: Email / Cite / Ex@o EndNote, ProCite,

RefWorks or Reference
1. An economic perspective on experience tManager.

orts
Bs

mies in renewable e

Maya Papineau. Energy Policy. Kidlington: Mar 2006. Vol. 34, Iss. 4, p. 4

B Find a copy B Abstract

22

2. The economics of large-scale wind power in a carbon constrained world

Joseph F DeCarolis, David W Keith. Energy Policy. Kidlington: Mar 2006. Vol. 34, Iss. 4; p. 39

B Find a copy B Abstract

3. An assessment of governmental wind power programmes in Sweden - using a systems

K Astrand, L Neij. Energy Policy. Kidlington: Feb 2006. Vol. 34, Iss. 3, p. 277

B Find a copy B Abstract
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D. Get more citations - import

Step 1 — Save references from database to text file — Web of Science

1. Goto VERA and type Web of Science in

search box, open database.
2. Search on “wind power”.

3. At the Results page, in the Output
Records box, select All records on page,
select full record from the pull-down

menu, then click Save to File.

4. At the next window, select the Field
Tagged (plain text) option, then click

Continue.

5. Save as a text file to the desktop, or open
as a text file if your browser offers that
option. Copy contents of the text file to the

clipboard.

Sort by:

Latest date | (3080

Qutput Records:

() Selected records on page
ri All records on page

") Records to

‘Full Record i v
PRINT

O, EXPORT @‘.%l:f')m FILE

Or add them to the Marked List
for later output and more options.

==

CONTINUE

CANCEL

Select a data format for the saved file.

OHTML -View in a browser.

@ Field Tagged (plain text) -Import into a reference management tool.
C’Rab Delimited (Windows) -Import into a spreadsheet program.
O Tab Delimited (Mac) -Import into a spreadsheet program.

£

Step 2 — Import references from text file into RefWorks database

1. From References pull-down
menu, select Import.

2. From the Import menu select the
following from the pull-down
menus: Import Filter/Data
Source — ISI; Database — Web
of Science; Import References
into — Wind.

3. Select a file to import, and use
the text file you created, or
choose- Import Data from the
following Text, and paste the
text from the clipboard.

4. Click Import button to import
database records.

References v Search ~|View - Folders ~|Bibliography Tools ~|Help ~

IMport  bowto imoort | List of Filters & Dat:

bases | Reguest a Filter

Import Filter/Data Source 151 (Institute for Scientific Information)

Database Web of Science =

Import References into Specify Folder (optionall ! ¥

(Note that references are also put in the Last Imported folder)

2 Import Data from the following Text File

Browse:

Encoding | ANSI - Latin I

~ | Specify enly if you specifically set the enca

ding when saving the text file; othervi

(%) Import Data from the following Text

15 11
8P °

EP 9

PG 1

SC Engineering, Multidisciplinary; Instruments & Instrumentation
Gn 983VH

UT IS1:000233267800003

ER

EF

—

E. Get more citations — Google Scholar

Google

Scholar

Advanced Scholar Search

Scholar Preferences

Scholar Help

Number of
Results

Google's defaull (10 results) provides the fastest results
Display 30 + results per page.

Results Window Open search results in a new browser window

Bibliography Don't show any citation import links.

Manager

#Show links to impert citations into | EndNote
BibTeX

- Refian
Save your preferences when finished and return to %0 o efWorks

s NenXianwang |
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V. Working with RefWorks

Folders:

- All references belong to a common database. The View pull-down menu, and Show

All References option gets you into the common database.

- The Last Imported folder always contains the most recent additions. When new
records are added they replace the records that were in the folder before.

- All other folders are those you create.

- Citations can belong to more than one folder. It is a primary tool for organizing your

references in a sensible way.

Editing existing records and creating new ones:

- Any record can be edited by clicking edit on the right margin of the record display.
- There is ample room and choice of fields to make all kinds of comments and notes.

supports note-taking by multiple users.

- There is help provided about formatting and data entry conventions within the edit
mode.

- Create new records from the Reference pull-down menu and the Add New
Reference option.

SFX:
- Click on SFX button to check library holdings and link back to full text of articles.

- SFX s easy. Not 100% reliable. If an SFX search fails to provide positive results,

double check our holdings in Barton and Vera.

Stand alone bibliography:
Create or select folder containing the references you want in your bibliography.

- Select Bibliography from top menu bar.

- From the Bibliography menu select the output style, file type, and folder from the
appropriate pull-down menus.

- Click Create Bibliography button.

Sharlng RefWorks folders:

From Folders pull-down menu, select Share Folders option
- Alist of your folders will appear, click Share Folders button next to folder.
- Make your sharing options for your folder.

- A URL for your folder will be generated that can be shared via email or as a link on a

web page.
V1. RefWorks Help

Tutorial: http://refworks.com/tutorial/
Help pages: https://refworks.com/Refworks/help/helpmainframe.asp
Library web pages: http:/libraries.mit.edu/help/refworks/index.html
Note about off-campus issues
EndNote support: http://libraries.mit.edu/help/endnote/index.htmi




